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Important information
WAR N I N G

l Failure to follow the installation instructions shipped with your SMART product could result in
personal injury and damage to the product.

l Ensure that any cables extending across the floor to your SMART product are properly
bundled andmarked to avoid a trip hazard.

l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

l Do not push foreign objects into the openings on your SMART product.

l Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

l The camera arm on your SMART product has joints that present a pinch hazard when you
move the camera arm. Keep clear of the pinch points.

l Do not stare into the light or shine the light directly into someone’s eyes. Turn off the light
when displaying or capturing images of people.

l Do not overload power outlets or extension cords as this can result in a fire or electric shock.

l Turn off and disconnect your SMART product before a thunderstorm. During a thunderstorm,
do not touch your SMART product or the power plug, because there is a risk of electrical
shock.

l Only use your SMART product with the type of power source that is written on the power
supply and do not modify the plug.

C A U T I ON

l Place your SMART product on a solid surface to prevent it from falling.

l If you have a security cable attached to our SMART product, do not carry or swing your
SMART product by the security cable.
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l Do not connect non-shielded interface cables to your SMART product and do no leave cables
connected to unused connectors, because this can cause interference levels that exceed
FCC regulations.

l Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

l Do not block or cover the openings or slots on your SMART product. These slots provide
ventilation, ensure reliable operation and protect your SMART product from overheating.

l Do not carry your SMART product by the camera arm. Carry it by the base of the unit.

l Do not aim the camera lens at the sun.

l If your SMART product requires replacement parts, make sure the service technician uses
replacement parts specified by SMART Technologies or parts with the same characteristics
as the original.

I M P O R T A N T I N F O R M A T I O N
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Introduction
Your document camera 450 can transform any classroom or lecture hall into a spontaneous and
interactive learning environment. It uses a high-resolution video camera to display clear and detailed
images of writtenmaterial or any physical object.

Chapter 1
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Your SMART Document Camera™ 450 enables you to display printed documents, microscope slides
and 3D objects on your computer, projector or television. You can record videos, scan documents,
capture images and save them to a SMART Notebook™ collaborative learning software file or to an
SD/SDHC card or USB drive.

Your document camera integrates with SMART Notebook software and SMART Board® interactive
whiteboards, creating an interactive presentation environment.

You can use themixed reality cube with your document camera tomanipulate 3D models in
SMART Notebook files.

Document camera features

Camera
l High resolution 5MP CMOS sensor

l 8× optical zoom, 8× digital zoom

l Internal memory

l Up to 30 frames per second

l Automatic or manual focus

l Maximum shooting area 15 3/4" × 11 3/4" (40 cm × 30 cm)

l Microphone integrated into base

l Microscopemode that requires adapters

Output/input
l VGA and DVI-I outputs XGA (1024 × 768), SXGA (1280 × 1024), 720p (1280 × 720), 1080p (1920

× 1080)

l Composite video output with user-selectable NTSC or PAL formats

l RGB (VGA) input (when selected by the user) is a pass-through to the VGA output.

Physical construction
l Security lock slot

l Flexible arm

l Bright LED overhead light

C H A P T E R 1
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Software
l SMART Notebook software 11 or later, including 3D Tools for SMART Notebook software and

Mixed Reality Tools software.

l SMART Product Drivers

Image and video storage
l Supports SD/SDHC cards with a built-in card slot (up to 32GB, speed glass 4).

l Supports USB drivers.

l Supports USB mass storagemode for internal memory and SD card when connected to a
computer.

Parts of the document camera

Adjustable camera arm and camera head
You can fold and adjust the flexible arm to position the lens at any angle. The camera head has a
bright LED overhead light to enhance the lighting condition.

1

2

3

4

5

Camera head

Camera lens

Overhead light

Flexible arm

Control panel

Control panel
You can use the control panel to switch between Camera, Computer Pass-Through and Playback
modes. You can also use it to control features and settings in the Cameramode's on-screen display
menu.

C H A P T E R 1
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Button

1 Select/Enter 7 Select playback

2 Menu 8 Overhead light on/off

3 Record video 9 Image brightness

4 Power on/off 10 Zoom in/out

5 Select camera 11 Auto-focus

6 Select computer pass-through 12 Capture to SMART Notebook software or to local memory

13 USB indicator: computer or USB drive
For information on the different modes, seeUnderstanding Camera, Computer Pass-Through and
Playback modes on page 23.
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Rear connection panel
The rear connection panel has DC 12V 2A, VGA In, VGA Out, Composite VideoOut and USB mini-B
connectors.

1 Connect the power cable

2 Connect a VGA output connector of a computer

3 Connect any display device with a VGA cable

4 Connect the supplied composite video adapter cable

5 Connect a USB connector of a computer

Left-side connection panel
The left-side connection panel has a DVI output, a switch for selecting either a computer or a USB
drive, and audio in and out connect.

1 Connect any display device with a DVI cable

2 USB switch

3 Connect a USB drive

4 Connect an external microphone

5 Connect speakers for video playback only

C H A P T E R 1
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Right-side connection panel
The right-side connection panel has an SD/SDHC card slot, a switch for selecting VGA-DVI or
composite video output and a security lock slot.

1 Camera head storage

2 SD/SDHC card slot

3 TV/VGA switch

4 Security lock slot

Bottom control panel
The NTSC/PAL switch is on the bottom control panel. This switch enables you to change the format
of the composite video output for your television. Changes to the selected video output take effect the
next time you turn on your document camera. The resolution reset button resets the output VGA/DVI
resolution to XGA.

N OTE

You can press the resolution reset button with a pen tip. Pressing the button for three seconds
resets the output VGA/DVI resolution to 1024 × 768.

C H A P T E R 1
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1
2
NTSC/PAL switch
Resolution reset button

Mixed reality cube
With amixed reality cube, you can interact with 3D models in SMART Notebook software using
Mixed Reality Tools. SeeUsing 3D Tools for SMART Notebook software andMixed Reality Tools on
page 59.

Power supply
Your document camera comes with a power supply, including a country-specific connector that
connects to the external power supply. Plug adapters for North America, Great Britain, Europe and
Australia are provided.

USB cable
Use the USB cable to connect your document camera to your computer. You can display objects,
capture images to SMART Notebook files and control your document camera from SMART Notebook
software.

VGA cable
Use the VGA cable to connect your document camera to a computer, projector or display. You can
display objects and capture images and videos to a storage device.

C H A P T E R 1
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Composite video adapter cable
Use the composite video adapter cable to connect your document camera to a projector or a display.
You can display objects, capture images and videos to a storage device and use the features in the
on-screenmenus.

N OTE

The provided DB9 connector isn’t needed in any of the connection configurations.

Microscope adapter
Your document camera comes with amicroscope adapter and two different sized rubber couplers to
fit themicroscope eyepiece. With amicroscope you can examinemicroscopic objects on a big
screen.

Anti-glare sheet
Place the anti-glare sheet over printed documents to reduce glare.

Document camera modes
Your document camera has threemodes you can use to control how it sends data to a computer,
projector, monitor or television.

l Cameramode controls your document camera from its control panel and displays images on a
projector, monitor or television.

l Computer Pass-Throughmode displays the image from the VGA input on a projector, monitor or
television connected to the VGA output.

l Playback mode controls your document camera from its control panel and displays images from
an SD/SDHC card or USB drive on a connected projector, monitor or television.

SeeUnderstanding Camera, Computer Pass-Through and Playback modes on page 23 for more
information on thesemodes.
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Document camera software
Your document camera includes software downloads that you need to present images from your
document camera.

SMART Notebook software and SMART Product Drivers
Your document camera uses SMART Notebook software and SMART Product Drivers.
SMART Notebook software is presentation software designed to work with
SMART Document Cameras and the touch features of SMART Board interactive whiteboards. In
addition, with amixed reality cube, you canmanipulate 3D models in SMART Notebook files using
Mixed Reality Collaboration tools (seeUsing 3D Tools for SMART Notebook software andMixed
Reality Tools on page 59).

You can find system requirements for your computer in theSMART Notebook software 11.1 release
notes (smarttech.com/kb/170138).

I M P OR TA N T

You need to have SMART Notebook software 11 SP1 or later installed on your computer before you
connect your document camera.

Downloading software

To install SMART Notebook software and SMART Product Drivers

1. Go to smarttech.com/software.

2. Scroll toSMART Notebook collaborative learning software.

3. Click Choose a version, select the latest version of SMART Notebook software forWindows®
orMac, and then follow the on-screen instructions.

C H A P T E R 1
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Introduction
This chapter explains how to set up your document camera and how to connect with different
displays and devices. It also explains external memory storage usage.

Chapter 2
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Setting up your document camera
The document camera has a flexible arm with rotational movement for easy positioning display
objects.

To unfold and position your document camera

1. Place a hand on the base of the document camera to stabilize it.

2. Press the camera head down, and then pull the camera arm outward and upward.

3. Move the camera head to aim the lens at your object.

I M P OR TA N T

To use your document camera with SMART Notebook software you need to connect your
document camera to a computer.

C H A P T E R 2
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To connect the power supply

1. Connect the power supply cable to theDC 12V receptacle on the rear connection panel.

2. Connect a country-specific connector to the power supply.

3. C A U T I ON

Ensure you connect the power connector to the power supply before connecting the power
plug to a power outlet.

4. Connect the plug to a power outlet.

To use your document camera in Camera or Playback mode, connect your document camera directly
to an external display.

To connect your document camera to a computer with a USB cable

1. Set the USB switch on the left side connection panel to .

The indicator on the control panel lights up, and you can use your document camera as a
USB camera or to transfer captured pictures/videos from thememory source to your computer.

2. Connect a USB cable to the USB receptacle on the rear connection panel.

3. Locate the USB connector on your computer, and then connect the cable to it.

To connect your document camera to a computer with a VGA cable

1. Connect a VGA cable to theVGA In receptacle on the rear connection panel.

2. Locate theVGA Out connector on your computer, and then connect the cable to it.

Connecting your document camera to different
displays
After you complete the basic connection procedure, you can connect your document camera to an
external display. This enables you to use the document camera in Cameramode and Playback mode
(see page 23) and to access the on-screen display menu for thosemodes.

C H A P T E R 2
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You can connect your document camera directly to an external display to enable the following
functions:

l UseCameramode to view the camera image in full-screen on the external display.

l Use Playback mode to view a full-screen slide show on the external display.

I M P OR TA N T

To use your document camera with SMART Notebook software you need to connect your
document camera to a computer.

Setting the TV/VGA switch
The TV/VGA switch determines the display output selection. Set it toVGA (right) when using a

VGA or DVI connection for a signal output. Set it to TV (left) when using an RCA connection for
a composite output.

Connecting your document camera to amonitor or a projector
In this configuration your document camera is connected to your external display device with a VGA
cable.

To connect your document camera to a monitor or a projector

1. Complete the basic connection steps (see page 12).

I M P OR TA N T

Make sure the TV/VGA switch is set toVGA .

2. Connect a VGA cable to your document camera's VGA Out receptacle and your display
device's VGA In connector .

Connecting your document camera to amonitor or a projector with a DVI
interface
In this configuration your document camera is connected to your external display device with a DVI
cable (not supplied).

C H A P T E R 2
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To connect your document camera to a monitor or a projector with a DVI interface

1. Complete the basic connection steps (see page 12).

I M P OR TA N T

Make sure the TV/VGA switch is set toVGA .

2. Connect a DVI cable to your document camera's DVI Out receptacle and your monitor's or
projector’s DVI Input connector.

3. Connect your document camera to an external display with a VGA cable (see page 16).

This configurationmakes it easy to transition from Computer Pass-Throughmode to Camera
mode or Playback mode using the same projector or display for all threemodes.

Connecting your document camera to a TV or a projector
In this configuration your document camera is connected to your computer with both a composite
video adapter cable and an RCA cable.

To connect your document camera to a TV or a projector

1. Complete the basic connection steps (see page 12).

2. Connect a composite video adapter cable to your document camera's Composite Video
receptacle.

3. Connect an RCA cable to your display's Video In connector.

4. Connect the composite video adapter and the RCA cables (see page 16).

I M P OR TA N T

Do not connect the 9-pin cable

DVI or composite video displays will not display your computer view. A VGA display is
required.

C H A P T E R 2
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Turning you document camera on and off

To turn on your document camera

Press the power button on the control panel.

The power light changes from amber to flashing green. When the light is solid green, your
document camera is operational.

To turn off your document camera

Press the power button on the control panel.

The power light changes from green to amber.

Connecting your document camera to
external devices
You can connect your document camera directly to the following external devices:

l Microscope

l Microphone

l Speakers

Connecting your document camera to amicroscope
You can connect your document camera to amicroscope. This enables you to examinemicroscopic
objects on a big screen.

To set up a microscope

1. Select the appropriate rubber coupler size for themicroscope eyepiece and insert it in the
microscope adapter.

C H A P T E R 2
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2. Attach themicroscope adapter to your document camera's camera head, and then connect it to
your document camera.

3. Tighten the three bolts until the adapter secures the eyepiece.

4. Fit the camera head with themicroscope adapter over themicroscope's eyepiece.

I M P OR TA N T

Make sure the arrow on the camera head andmicroscope adapter are on the same side.

5. Turn themicroscope adapter counterclockwise to line up the arrows and lock themicroscope
adapter in place.

C H A P T E R 2
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To connect the microscope to a projector or a display

1. Press the button on the control panel, and then select the tab.

2. Use the button on the control panel to selectMODE, and then press the button on the
control panel.

3. Use the button on the control panel to select , and then press the button on the
control panel.

4. Press the button on the control panel to close themenu.

5. Connect the other end of the VGA cable to theVGA In connector on your projector or display.

6. Set the VGA/TV switch on the right-side connection panel toVGA .

Switching between VGA, DVI and composite output
If you’re using a projector or a computer display with a VGA or a DVI cable, set your document
camera to the VGA mode. If you’re using a television with the composite video cable, set your
document camera to the TV mode

To set your document camera to the VGA mode

Set the VGA/TV switch on the right-side connection panel toVGA .

To set your document camera to the TV mode

Set the VGA/TV switch on the right-side connection panel to TV .

Connecting your document camera to an external microphone
You can connect an external microphone to your document camera.

N OTE S

l The built-in microphone on the control panel is disabled when an external microphone is
connected.

l The audio is in monophonic sound.

C H A P T E R 2
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To connect an external microphone to your document camera

Connect themicrophone's cable to themicrophone on your document camera's left-side
connection panel.

Connecting your document camera to speakers
You can connect speakers to your document camera. Only audio from the video playback is
supported.

C A U T I ON

Turn the volume down to prevent hearing damage when using earphones.

To connect speakers

Connect the speakers’ 3.5 mm cable to the speaker receptacle on your document camera's left-
side connection panel.

Shooting area, overhead light and anti-glare
sheet

Shooting area
The shooting area can view amaximum area of 15 3/4" × 11 3/4" (40 cm × 30 cm).

To rotate the image

1. Press the button on the control panel.

2. Press the button on the control panel, and then select .

3. Press the button on the control panel.

4. Press the button on the control panel, and then select ROTATE.

5. Press the button on the control panel.

6. Select rotation range, and then press the button on the control panel.

7. Press the button on the control panel to close themenu.

C H A P T E R 2
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To mirror the image

1. Press the button on the control panel.

2. Press the button on the control panel, and then select .

3. Press the button on the control panel.

4. Press the button on the control panel, and then selectMIRROR.

5. Press the button on the control panel.

6. Select ON orOFF, and then press the button on the control panel.

7. Press the button on the control panel to close themenu.

Overhead light
Press the button on your document camera's control panel to turn the overhead light on or off.

Anti-glare sheet
The anti-glare sheet is a special coated film that helps eliminate any glare that could be encountered
while displaying glossy objects, such as magazines and photos. Place the anti-glare sheet on top of
the object to reduce reflected light.

C H A P T E R 2
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External memory storage
Your document camera supports both an SD/SDHC card and a USB drive for image capture, audio
and video recordings. Your document camera detects when an external storage device is connected
and automatically switches to the last detected storage. If no external storage device is connected,
all captured images are saved in the built-in memory.

I M P OR TA N T

Your document camera comes with piece of plastic inserted in the SD card slot. Remove this piece
of plastic before you insert your SD/SDHC card.

N OTE S

l Your document camera supports SD/SDHC cards with up to 32GB, speed class 10.

l SDHC card with class-6 or higher is recommended for high-quality recording.

l Push in the SD/SDHC card to eject it.

To connect a USB drive

1. Set the USB switch on the left-side connection panel to .

Your document camera detects the USB drive and the indicator on the control panel
lights up.

2. Insert the USB drive into the USB receptacle.

N OTE S

Your document camera supports USB drives with up to 64GB.

C H A P T E R 2

Setting up your SMART Document Camera

21





Chapter 3: Using your
SMART Document Camera
Introduction 23
Understanding Camera, Computer Pass-Through and Playback modes 23

Cameramode 23
Computer Pass-Throughmode 24
Playback mode 24

Identifying features of eachmode 25
Setting document cameramodes 26
Displaying printed documents 27
Inserting and removing an SD/SDHC card 28

Introduction
This chapter provides information about your document camera's different modes.

Understanding Camera, Computer Pass-
Through and Playback modes
You can use your document camera in Camera, Computer Pass-Through or Playback mode. Each
mode enables you to complete different functions and requires a specific connection to either a
display, a projector or a computer.

Cameramode
In Cameramode, you can view document camera images only in SMART Notebook software.

Cameramode allows connection over USB and live image output. You can view full-screen images
from your document camera using a projector or high-definition display without a computer.

Chapter 3
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You can save images to your SMART Notebook file to present them later, or if your computer is
connected to an interactive whiteboard, projector or television, you can deliver your
SMART Notebook presentation with live images from your document camera.

N OTE

The Capture button on the control panel saves the image to the Notebook page and closes the
SMART Document Camera window. Pressing the Capture button again will re-open the
SMART Document Camera window.

You can use the Cameramode’s on-screen display menu for greater control of the image.

SeeUsing your SMART Document Camera in Cameramode on page 31.

Computer Pass-Throughmode
Computer Pass-Throughmode switches your document camera's video output to the VGA input. You
can switch between the live camera image and your computer screen image.

You can view the document camera live image only in SMART Notebook software.

N OTE S

l Capture button on the control panel has no effect in Computer Pass-Throughmode.

l In Computer Pass-Throughmode, you can only view the document camera live image in
SMART Notebook software.

Playbackmode
In Playback mode you can view full-screen images and slide shows from thememory card on a
projector or high-definition display without a computer. You can’t use your document camera as a
mass storage device in Playback mode.

C H A P T E R 3
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Identifying features of each mode
The following table describes the differences between eachmode.

Feature description Camera
mode

Computer
Pass-Through
mode

Playback
mode

View computer input (VGA In) No Yes (VGA out and
DVI analog)

No

View document camera image Yes No No

View pictures from amemory card No No Yes

Access an internal memory and SD/SDHC card from
the computer with a USB cable

Yes[1] Yes[1] No

Control the document camera from a computer Yes Yes[1] No

Capture to SMART Notebook software Yes No No

Capture to an SD/SDHC memory card Yes No No

Access the related on-screen display menu Yes No Yes

Capture to a USB drive Yes [2] No No

N OTE S

l [1] Only when the USB switch is set to . See The Setting tab on page 39.

l [2] Only when the USB switch is set to . See The Setting tab on page 39.

The following table describes outputs when your document camera is connected to a display with
VGA, DVI or Composite VideoOut.

Feature description Camera
mode

Computer
Pass-Through
mode

Playback
mode

Connect to a projector or display (VGA
out and DVI analog output)

Camera
image

VGA In Memory
card
images

C H A P T E R 3
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Feature description Camera
mode

Computer
Pass-Through
mode

Playback
mode

Connect to a DVI digital output projector
or a display

Camera
image

N/A Memory
card
images

Connect to a television (composite video
out)

Camera
image

N/A Memory
card
images

Setting document camera modes

To set your document camera to Camera mode

1. Set your document camera to Computer mode using the switch on the left-side connection

panel. The USB indicator on the control panel displays .

2. Connect your document camera to your computer with the USB cable.

3. Set the TV/VGA switch on the right-side connection panel to VGA .

4. Connect your document camera to a projector, monitor or television with a VGA cable.

5. Press the button on the control panel.

To set your document camera to Computer Pass-Through mode

1. Connect your document camera to your computer with the USB cable.

2. Connect your computer with the VGA cable to your document camera's VGA In receptacle.

3. Connect your display device with another VGA cable to your document camera's VGA Out
receptacle.

4. Press the button on the control panel.
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To set your document camera to Playback mode

1. Disconnect the USB cable from the rear connection panel.

2. Connect your document camera to a projector or amonitor with the VGA cable or to a television
with the composite video adapter cable if needed.

3. Press the button on the control panel.

Displaying printed documents
When you set your document camera to Cameramode, you can display printed documents, use the
anti-glare sheet to reduce glare, and optimize the image for text and graphic documents with the
Imagemode options.

To display printed documents

1. Place your documents on the table.

2. Adjust the document camera, and then aim its lens at your documents.

3. Press the button on the control panel to adjust the focus.

To reduce glare

If glaremakes it difficult for you to read the printed documents that you’re displaying, place the
anti-glare sheet on top of the printed documents.

To optimize the image for text documents

1. Set your document camera to Cameramode.

2. Press the button on the control panel.

The on-screen display menu appears.

3. Press the button on the control panel to select , and then press the button on the
control panel.

4. Press the button on the control panel to select IMAGE MODE, and then press the
button on the control panel.
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5. Press the button on the control panel to select , and then press the button on the
control panel.

See The Image tab on page 34 for an explanation of the settings.

To optimize the image for documents with graphics

1. Set your document camera to Cameramode.

2. Press the button on the control panel.

The on-screen display menu appears.

3. Press the button on the control panel to select , and then press the button on the
control panel.

4. Press the button on the control panel to select IMAGE MODE, and the press the
button on the control panel.

5. Press the button on the control panel to select , and then press the button on the
control panel.

See The Image tab on page 34 for an explanation of the settings.

Inserting and removing an SD/SDHC card
Your document camera has an SD/SDHC card slot on the right-side connection panel. You can save
document camera images to an SD/SDHC card when your document camera is in Camera or
Computer Pass-Throughmode. When your document camera is in Playback mode you can display
previously captured images from an SD/SDHC card.

C A U T I ON

Avoid static electricity near a card because it can damage.

I M P OR TA N T

Your document camera comes with a piece of plastic inserted in the SD/SDHC card slot. Remove
this piece of plastic before you insert your SD/SDHC card.
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To insert an SD/SDHC card

1. Press the button on the control panel.

2. Insert an SD/SDHC card into the card slot on the right-side connection panel with the contact
facing down.

I M P OR TA N T

l Youmight need to set your document camera to use the SD/SDHC card as the storage
location (see The Setting tab on page 39).

l Ensure the label on the SD/SDHC card is facing up.

To remove an SD/SDHC card

C A U T I ON

To prevent memory card damage, do not remove thememory card while capturing or deleting
images.

1. Press the button on the control panel and wait until your document camera displays a live
image.

2. Push in the card to eject it, and then remove the card.
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Introduction
This chapter explains how to use your document camera in Cameramode.

Using Camera mode
When your SMART Document Camera is connected to a projector, flat-panel display or television
you can display a full-screen image from your document camera.

You can use your document camera in Cameramode to perform the following tasks:

l Display objects.

l Capture images to an SD/SDHC card.

l Capture images to SMART Notebook.
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l Use the features and settings in the on-screen display menu.

l Use amicroscope with a standard eyepiece with additional adapters.

I M P OR TA N T

Your document cameramust be connected directly to an external display when using the OSD
menu. SeeConnecting your document camera to external devices on page 16.

To switch to Camera mode

1. Connect your document camera to a projector or flat-panel display with the appropriate cable
(seeConnecting your document camera to external devices on page 16).

2. Press the button on the control panel.

To display objects

1. Press the button on the control panel.

2. Place the object you want to display under the camera.

3. Rotate the camera head to aim the lens at your object.

To adjust the zoom magnification

Press the button on the control panel.

To automatically adjust the focus

Press the button on the control panel.

To adjust brightness settings

Press the button on the control panel.

To record a video

1. Insert an SD/SDHC card or USB drive into the appropriate receptacle.

2. Press the button on the control panel to start recording.

3. Press the button on the control panel to stop recording.
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Using the on-screen display (OSD) menu in
Camera mode
There are four tabs on theOSD menu: Image, Presentation, Setting and System. Use theOSD menu
to adjust settings for your document camera in Cameramode.

To navigate the OSD menu and submenus

1. Set your document camera to Cameramode.

2. Press the button on the control panel.

TheOSD menu appears.

3. Press the and buttons on the control panel to toggle between tabs.

4. Press the and buttons on the control panel to choose a selection in themenu list.

5. Press the button on the control panel to make a selection.

6. Press the button on the control panel to enter a submenu.

7. Press the button on the control panel to return to the previous menu level.

8. Press the button on the control panel to exit themenu.

The following OSD menu options are available when your document camera is in Cameramode.

Tab Options

Image Brightness, Contrast, Mode, Effect, Mirror, Advanced, Focus, Rotate.
See The Image tab on the next page.

Presentation Picture in Picture (PiP), Split Screen, Timer. See The Presentation tab on
page 36.

Settings Capture, Recording, Storage, Format, USB to PC and Flicker.

System Language, Output Display, Backup, Save Setting, Recall Setting,
Information, Default.
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The Image tab

To access the Image settings menu

1. Press the button on the control panel.

2. Press the button on the control panel.

3. Press the button on the control panel to select , and then press the button on the
control panel.

4. Press the or button on the control panel to select , and then press the button
on the control panel.

Image options Description

Brightness Adjust the image brightness manually.

Contrast Adjust the image contrast.
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Image options Description

Mode Select an option from five image settings:

o Sharp – adjust the contrast to make text appear more
visible

o Graphics – adjust the image gradient

o Motion – increase the frame rate (sufficient lighting is
required when using this setting)

o Macro – set when viewing an object that is close to the
camera, nomore than 7 3/4" (20 cm) away from the camera

o Infinite – set when viewing an object that is more than
22" (55 cm) away from the camera

Effect Convert the image to color, black/white or film negative image.

Mirror Select to flip the image:
o OFF – displays a normal image
o ON – displays amirrored image

Advanced

o Auto Image Select to automatically adjust white balance and exposure, and to
correct color and exposure compensation.

o Exposure Select the exposure setting:
o AUTO – automatically adjust the camera exposure
o MANUAL –manually adjust the camera exposure

o White Balance Select the white balance setting for various light conditions:
o AUTO – automatically adjust the white balance

o MANUAL –manually adjust the red and blue color levels up
to 255.

Focus Adjust the focus manually.

Rotate o OFF – displays normal image rotation
o 90° – rotates the image 90°
o 180° – rotates the image 180°
o 270° – rotates the image 270°
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The Presentation tab
Presentation features enable you to show previously captured images along with the live camera
view. These features aren't available when the document camera is connected as a USB camera.

To access the Presentation tab

1. Press the button on the control panel.

2. Press the button on the control panel.

3. Press the button on the control panel to select , and then press the button on the
control panel.

4. Press the button on the control panel to select , and then press the button on the
control panel.
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Presentation options Description

Picture in Picture (PiP) o Shows captured pictures or video as thumbnails in corner of
the screen in Cameramode.

o Press the left and right navigation buttons to navigate
through the stored images.

o Press the button to cancel PiP.

Split Screen o Divides the screen in two parts.
o Half of the screen displays thumbnail images and the other

half displays the image from your document camera.
o Select the display location: left, right, top, bottom.

o Press the left/right and up/down navigation buttons to
highlight the image.

o Press the button to select the image.

o Press the left/right and up/down navigation buttons to pan
the stored image.
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Presentation options Description

o Press the button to cancel split screen.
o N OTE

You can’t capture an image while in Split Screenmode.

Timer o Provides an on-screen countdown timer for a presenter to
assist with presentation timemanagement.

Using the Picture in Picture (PiP) feature
The PiP feature allows you to display an image from storedmemory within the live camera image.
This is useful for showing before and after comparisons.

N OTE

The PiP feature is for display purposes only. You can’t capture an image while in PiP mode.

To display the PiP image

1. Display an object in Cameramode, and then press the button on the control panel.

TheOSD menu appears.

2. Press the button on the control panel to select , and then press the button on the
control panel.

3. Press the button on the control panel to select PiP, and then press the button on the
control panel.
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4. Select the corner of the display, and then press the button on the control panel.

Your document camera displays a picture in picture image.

5. Press and buttons on the control panel to choose different stored images.

The Setting tab

To access the Setting tab

1. Press the button on the control panel.

2. Press the button on the control panel.

3. Press the button on the control panel to select , and then press the button on the
control panel.

4. Press the button on the control panel to select , and then press the button on the
control panel.
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Settings options Description

Capture

o Resolution Select image capture size. In 5M setting, the capture
resolution is 2592 × 1944.

o Quality Select image quality; Finest, High, Normal.

o Type Select image capture type:
o Single – capture one picture at a time
o Continuous – capture consecutive pictures

o Interval Set the time interval for continuous capture. The length can
be set up to 600 sec (10min).

Recording Select the video recording compression setting.

Storage Change the storage location:
o Audio and video recording can be saved only on an

SD/SDHC card, or a USB drive.

Format Delete all the data in the selectedmemory.

USB to PC Select the status of your document camera when it’s
connected to the computer using a USB cable. Make sure
the USB switch on the left-side connection panel is set to

.
o Camera – can be used as a computer webcam, to

capture still images or to record a video
o Storage – transfer captured images or videos from the

memory to a computer hard drive
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Settings options Description

Flicker Select refresh rate:
o 50 Hz – sets frequency to 50 Hz
o 60 Hz – sets frequency to 60 Hz

Playbackmode
Playback mode sets how your document camera, computer and amemory card interact.

To access the Playback mode

1. Press the button on the control panel.

2. Press the button on the control panel.

3. Press the button on the control panel to select , and then press the button on the
control panel.

4. Press the button on the control panel to select USB to PC, and then press the button
on the control panel.

5. Select STORAGE, and then press the button on the control panel.

Action Storage Camera

See thememory card from your computer Yes No

View and use your document camera from SMART Notebook
software

No Yes

Capture image to thememory card in both Computer Pass-
Through and Cameramodes

No Yes

This mode enables you to see the contents of your USB drive or SD memory card from your
computer.

Themass storagemode enables you to see the contents of the embeddedmemory or SD/SDHC
card from your computer. They will show up as removable disks. Look in the document camera DCIM
directories for the stored images and videos.”
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The System tab

To access the System menu

1. Connect your document camera to a projector, flat-panel display or television (see page 16).

2. Press the button on the control panel.

3. Press the button on the control panel.

TheOSD menu appears.

4. Press the button on the control panel to select , and then press the button on the
control panel.

System options Description

Language Select or change the language:
o English
o Français
o Deutsch
o Español
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System options Description

Output Display Set the resolution to display an image on the screen:
o 1024 × 768
o 1280 × 1024
o 1280 × 720
o 1920 × 1080

N OTE

This selection disabled in TV output mode.

Backup o SD/SDHC – copy images and presentations from the
build-in memory to an SD/SDHC card

o USB drive – copy images and presentations from the
build-in memory to a USB drive

Save Settings Save the current setting in the selected profile number.

N OTE

Only effect, mode, brightness and contrast settings can be
saved.

Recall Settings Restore the setting to the selected profile number.

Information Display the product information.

Default Restore all the settings to the factory default settings.

Capturing and transferring images and videos
You can capture images and videos from your document camera to an SD/SDHC card or USB drive
and transfer them to a computer.

Capturing images
You can capture images and videos to an SD/SDHC card or USB drive when your document camera
is in Cameramode.

To capture images to memory

1. Set your document camera to Cameramode. SeeUsing Cameramode on page 31.

2. Position your document camera.

3. Adjust any camera settings using the Cameramode’s OSD menu. SeeUsing Cameramode on
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page 31.

4. Press the button on the control panel.

To record a video using an SD/SDHC card

1. Insert an SD/SDHC card in your document camera's SD/SDHC card slot.

2. Press the button on the control panel to select , and then press the button on the
control panel.

3. Press the to select STORAGE, and then press the button on the control panel.

The document camera detects the SD/SDHC card.

4. Press the button on the control panel to start recording.

2. N OTE

The video saves in .AVI format in your SD/SDHC card.

5. Press the button on the control panel to stop recording.

To record a video using a USB drive

1. Insert a USB drive in your document camera’s USB receptacle.

2. Press the to select STORAGE, and then press the button on the control panel.

The document camera detects the USB drive.

3. Press the button on the control panel to start recording.

2. N OTE

The video saves in .AVI format in your USB drive.

3. Press the button on the control panel to stop recording.

Transferring images to your computer
You can transfer images from your external storage device to your computer.
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To transfer images to your computer

1. Use theOSD menu to set your document camera USB to PC mode toSTORAGE.

2. Connect your document camera to your computer with the USB cable (seeSetting up your
document camera on page 12).

Your computer recognizes your document camera and the external storage device as a
removable disk.

3. Browse to the removable disk on your computer, and then transfer the images to your computer.

Using a microscope
You can view themicroscope stage through the document camera using additional attachments. See
Connecting your document camera to external devices on page 16.

To display a microscope slide

1. Place a slide or object on the stage of themicroscope.

2. Focus themicroscope so that the subject is in sharp focus.

3. Position themicroscope under your document camera so the camera lens is aligned with the
microscope eyepiece.

C A U T I ON

Ensure you do not hit your document camera lens with themicroscope. This could damage
your document camera’s lens.

4. Press the button on the control panel.

5. Press the button on the control panel.

6. Press the button on the control panel to select , and then press the button on the
control panel.

7. Press the button on the control panel to selectMODE, and then press the button on the
control panel.

8. Press the button on the control panel to select , and then press the button on the
control panel.
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Using your document camera with
SMART Notebook software
You can display objects and capture an image to a SMART Notebook page.

You can present images from your document camera through SMART Notebook software. The
interactive whiteboard or projector displays your computer desktop or SMART Notebook file.

I M P OR TA N T

Your document camera should be in Cameramode. SMART Notebook software also works with
the camera in the Computer Pass-Throughmode. See The Setting tab on page 39.

N OTE

For information on using 3D Tools for SMART Notebook software andMixed Reality Tools for
SMART Document Camera, seeUsing 3D Tools for SMART Notebook software andMixed
Reality Tools on page 59.

To open a SMART Document Camera window

1. Connect your SMART Document Camera to your computer and turn on the document camera.

2. Start SMART Notebook software.

3. Press SMART Document Camera on the SMART Notebook menu bar.

A SMART Document Camera window appears.
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4. Place the object or objects you want to display under the camera.

5. Press any of the following on themenu bar to adjust the image.

Menu option Description

Zoom out.

Zoom in.

Decrease brightness.

Increase brightness.

Focus automatically.

Focus out manually.

Focus inmanually.

Change the appearance of the image: rotate it 180º, define the image color,
black and white or film negative. You can also start and stopMicroscope
mode and start Mixed Reality Tools for SMART Document Camera
automatically.

Start Mixed Reality.

Insert a screen capture on the current page and then close the window.

Capture an image and insert a screen capture on a new page and keep the
current window open.
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To take a series of screen captures

1. Open a SMART Document Camera window.

2. Press Capture with Time-Lapse on the SMART Document Camera window menu bar, and
then select a period of time. (For example, if you want to take a screen capture every 15
seconds, select 15 Seconds.)

3. When you’re done, press to stop recording.

N OTE

The display appears in the bottom left corner of your SMART Notebook page. It
displays the time that has lapsed since the last screen capture and the number of screen
captures taken.

To use a microscope

1. Connect your document camera to amicroscope. SeeConnecting your document camera to
external devices on page 16.

2. Open a SMART Document Camera window.

3. Press Additional Settings on the SMART Document Camera window menu bar, and then
select Start Microscope Mode.

N OTE

TheAdditional Settings button doesn’t appear if you’re using a
SMART Document Camera 230 with SMART Notebook software.

4. Press Additional Settings , and then select Stop Microscope Modewhen you’re done.
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Introduction
This chapter explains how you can use your document camera in Playback mode. When you set your
document camera to Playback mode, you can play back images from the SD/SDHC card, USB drive
or internal memory. You can browse through the stored images and display previously captured
images either individually or as a slide show.

N OTE

In this mode your document camera can’t be connected by a USB cable and youmust have images
stored in either internal or external memory source.

Setting your document camera to Playback mode
Playback mode takes over the video output of the document camera. Live images and USB functions
are not available during this time.

To set Playback mode using an SD/SDHC card

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13.
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2. Insert an SD/SDHC card in your document camera.

3. Press the button on the control panel.

To set Playback mode using a USB drive

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13.

2. Set the USB switch to . The USB indicator on the control panel is lit.

3. Press the button on the control panel.

Using the Playback mode on-screen display
(OSD) menu
The Playback modeOSD menu shows the source storage location and controls how stored images
are displayed.

PlaybackmodeOSDmenu options

To access the Playback mode OSD menu

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13

2. Set the USB switch to . The USB indicator on the control panel is lit.

OR

Disconnect the computer USB connection to change thememory location to the USB drive.

3. Press the button on the control panel.
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Playback mode OSDmenu

Playback menu option Description

Slide Show Displays all captured still images in an automated slide show.

Interval Sets the slide show interval (in 5 second increments) before
displaying the next image. Themaximum interval is 100 sec.

Effect Selects the slide show transition effect:

o Slide image

o Checker down

o Wipe down

o Split vertical out

o Split horizontal in

Current Storage Chooses the storage source if more than one is available. Detects
the storage source if only one is available.

Delete All Permanently deletes all the data in the selectedmemory source.

N OTE

A warningmessage appears. Select YES to continue orNO to
stop.

To select the settings for a slide show

1. Press the button on the control panel to access the Playback modeOSD menu.

2. Press the and buttons on the control panel to make a selection, and then press the
button on the control panel.
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3. Press the and buttons on the control panel to toggle between functions.

4. Press the button on the control panel to make a selection.

5. Press the button on the control panel to close themenu.

Repeat steps 2–4 as needed.

To play a slide show

1. Connect your document camera directly to a projector or another display. For connection
information, see page 13

2. Set the USB switch to . The USB indicator on the control panel is lit.

OR

Insert an SD/SDHC card or a USB drive in the appropriate receptacle.

3. Press the button on the control panel.

Thumbnail images from thememory source are displayed.

4. Press the button on the control panel.

5. Press the button on the control panel twice to start the slide show.

6. Press the button on the control panel to stop the slide show or to return to the thumbnails
view.
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To play a video

N OTE

In the thumbnails view, videos have a symbol in the top left corner of the thumbnail image.

1. Connect your document camera directly to a projector another display. For connection
information, see page 13

2. Set the USB switch to . The USB indicator on the control panel is lit.

3. Insert an SD/SDHC card or a USB drive in the appropriate receptacle.

4. Press the button on the control panel.

Thumbnail images from thememory source are displayed.

5. Press the and buttons on the control panel to toggle between images.

C H A P T E R 6

Using your SMART Document Camera in Playbackmode

55



6. Press the button on the control panel to select the video you want to play.

7. N OTE

Press the button to pause your video.

Press the or button to adjust the volume.

Press the button to rewind and the button to fast-forward.

8. Press the button on the control panel to stop the video or to return back to thumbnails view.

Deleting images in Playback mode
You can delete all images at once from your document camera’s threememory sources using the
OSD menu, or you can delete only selected images.
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To delete all images

I MPOR TA N T

You are unable to delete images from your computer in Playback mode. You can delete images
only from the threememory sources.

1. Select thememory source you want to delete all the images from.

2. Press the button on the control panel to access the Playback modeOSD menu.

3. Press the button on the control panel to select DELETE ALL.

4. Press the button on the control panel, and then press the button again tomake a
selection.

TheDELETE ALLwarning appears.

5. Press the or button on the control panel to select YES orNO.

6. Press the button on the control panel toDELETE orCANCEL.

7. Press the button on the control panel again to close the Playback modeOSD menu.

N OTE

The deleting-image icon appears briefly while your document camera deletes images.

To delete selected image

1. Press the button on the control panel to display all the images in thememory storage.

2. Press the or or or button on the control panel to select the image you want to
delete.

3. Press the button on the control panel.

TheDELETE THIS IMAGE warning appears.

4. Press the or button on the control panel to select YES orNO.

5. Press the button on the control panel toDELETE orCANCEL.
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Introduction
This chapter provides the information you need to begin using 3D Tools for SMART Notebook
software andMixed Reality Tools with your SMART Document Camera as well as SketchUp™
sketching software and Trimble® 3D Warehouse™ (formerly Google™ 3D Warehouse).

3D Tools for SMART Notebook software andMixed Reality Tools provide an intuitive way for
students and teachers to explore digital content with the document camera. This technology is
integrated with SMART Notebook software.
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3D Tools for SMART Notebook software andMixed Reality Tools take this experience to a new level
by providing teachers and students with a new way to engage with digital 3D content.

Incorporating 3D content into your lessons
You can incorporate 3D content into your SMART Notebook software lessons. The following are
examples of how to do this:

l If you’re teaching a biology lesson, insert a 3D model of a heart into your .notebook file. Rotate
and change the size of the 3D model to present the different parts of the heart.

l If you’re teaching an English lesson, insert a 3D model of a city that is referenced in a novel the
class is reading. Enter the 3D scene to navigate streets and interiors of buildings.

l If you’re teaching a primary lesson, insert multiple 3D models and use theDisguise feature to
reveal answers as amemory exercise.

Getting started with Mixed Reality Tools for
SMART Document Camera

Activating 3D Tools for SMART Notebook software and
Mixed Reality Tools
3D Tools for SMART Notebook software andMixed Reality Tools provide an intuitive way for
students and teachers to explore digital content with the SMART Document Camera.

When you connect your document camera to your computer, 3D Tools for SMART Notebook
software andMixed Reality Tools activate automatically. If you want to use 3D Tools for
SMART Notebook software on a computer that has never been connected to a document camera,
you can activate 3D Tools for SMART Notebook software by obtaining a product key and following
the procedure below.

N OTE

You can obtain a product key for 3D Tools for SMART Notebook software by registering your
document camera’s serial number at smarttech.com/register.

To activate 3D Tools for SMART Notebook software

1. ForWindows operating systems, select Start > All Programs > SMART Technologies >
SMART Tools > SMART Product Update.
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ForMac OS X operating system software, browse to and double-click
Applications\SMART Technologies\SMART Tools\SMART Product Update.

TheSMART Product Update window appears.

2. Click Activate in theSMART Notebook row.

TheSMART Software Activation dialog box appears.

3. Click Add.

4. Type the product key you received from SMART in theProduct Key box, and then click Add.

5. Click license agreement, review the license agreement, and then click Close.

6. If you accept the license agreement, select the I accept the terms in the license agreement
check box.

7. Click Next.

3D Tools for SMART Notebook software activates.

8. Click Finish, and then close theSMART Product Update window.

Hardware and software requirements
To get started with Mixed Reality Tools for SMART Document Camera, you need the following:

l SMART Notebook software 11 SP1

l SMART Document Camera 450

l A mixed reality cube

l A computer meeting the requirements in theSMART Notebook software release notes
(smarttech.com/kb/170421).
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Lighting requirements
Mixed Reality Tools works best in a bright room where the work surface doesn’t have any noticeable
shadows or glare.

The light must be as uniform as possible, shining on the cube and background. You can achieve this
by setting up the document camera so that the camera is facing directly down, perpendicular to a
uniform, neutral work surface. The work surface should not be darker than the black elements on the
mixed reality cube or lighter than the white elements on the cube.

N OTE S

l In very bright rooms, the work surface can appear whiter than the white elements on the cube.

l To help increase the contrast between the cube elements and the background, and to increase
the image frame rate, you can place a piece of white paper under the cube.

A typical projector room is usually quite dark. For Mixed Reality Tools to work properly, the document
camera’s light should be turned on. Don’t manipulate the cubemore than 14" (35 cm) from the
document camera.

N OTE

If SMART Notebook software doesn’t enter Mixed Reality mode when you hold the cube under the
camera, shake the cube under the camera. If the issue persists, press and hold the brighten button
on the document camera tomaximize the brightness.

Inserting and manipulating 3D models
To use 3D Tools for SMART Notebook software, you need to insert a 3D model in your .notebook file.
After you insert a 3D model, you canmanipulate it in the sameway youmanipulate other objects in
SMART Notebook software.

N OTE

You can insert 2D images and 3D models on the same page andmanipulate them the sameway
youmanipulate other objects in SMART Notebook software.
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Inserting 3Dmodels
3D models are available from the 3D Objects folder in Lesson Activity Examples and the
SMART Exchange™website (exchange.smarttech.com) as well as the Trimble 3D Warehouse (see
Using Trimble 3D Warehouse on page 73). You can also insert your own 3D models if they are in one
of the following formats:

l COLLADA (.dae)

l 3D Object (.obj)

l FBX (.fbx)

N OTE

Textures and other information for some 3D models are stored in separate files and folders. When
you insert these 3D models, ensure the 3D model file is located in the correct folder structure with
the supporting files and folders.

To insert a 3D model

1. Select Insert > 3D File.

The Insert 3D File dialog box appears.

2. Browse to and select the 3D model you want to insert.

3. Press Open.

The 3D model appears on the page.

Manipulating 3Dmodels
After inserting a 3D model, you canmanipulate it in the sameway youmanipulate other objects in
SMART Notebook software. In particular, you can do the following:

l Cut, copy and paste

l Clone

l Move

l Scale

l Lock

l Attach links and sounds

l Add to the Gallery tab
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N OTE S

l For information on these basic options, see the Help for SMART Notebook software.

l When you add a 3D model to the Gallery tab, it appears in the 3D Objects category.

In addition to these basic options, you can do the following:

l Rotate the 3D model

l Pause, resume, play and restart animation

l Add labels

Rotating a 3D model
You can rotate a 3D model alongmultiple axes. After rotating a 3D model, you can reset it to its
original orientation.

To rotate a 3D model along a single axis

1. Select the 3D model.

2. Press and hold one of the side rotation handles.

3. Drag your finger around the center of the 3D model, and then release your finger when done.

To rotate a 3D model along multiple axes

1. Select the 3D model.

2. Press and hold the center rotation handle.

3. Drag your finger in the direction you want to rotate the 3D model, and then release your finger
when done.

To reset a 3D model to its original orientation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Reset Rotation.

Pausing, playing and restarting animation
If a 3D model contains animation, you can pause, resume and restart the animation.
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N OTE

If a 3D model doesn’t contain animation, theAnimation menu documented in the following
procedures is disabled.

To pause animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Animation > Play/Pause Animation.

To resume playing animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Animation > Play/Pause Animation.

To restart animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Animation > Restart Animation.

Adding labels
You can use labels to highlight different components of a 3D model. Labels can be text, shapes or
other 2D objects.

To add a label

1. Select the 3D model.

2. Right-click the 3D model where you want to connect the label, and then select Add Label.

A label appears.

3. To use text in the label, double-click the label’s default text and then type your own text.

OR

To use a shape or other 2D object in the label, create the object and then drag it into the label.

4. Optionally, drag the label’s connection point to a different location on the 3D model.

To hide and display a label

1. Press the label’s connection point on the 3D model.
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The label is hidden.

2. Press the label’s connection point to display the label.

To remove a label

1. Select the label.

2. Press Close .

Navigating 3D scenes
Large 3D models that contain internal details are called 3D scenes. You can navigate 3D scenes
using controls in SMART Notebook software.

N OTE S

l You can use the navigation controls to navigate any 3D model. However, not all 3D models
contain internal details. If you enter a 3D model that doesn’t contain internal details, the interior
appears empty or dark.

l If you’re usingMac OS X operating system software, you’re unable to enter a 3D scene while
in Full Screenmode. To enter a 3D scene, first exit Full Screenmode and then complete the
following procedure.

C H A P T E R 7

Using 3D Tools for SMART Notebook software andMixed Reality Tools

66



To navigate a 3D scene

1. Select a 3D model.

2. Press the 3D model’s menu arrow, and then select Enter 3D Scene.

SMART Notebook software displays the 3D scene in Full Screenmode. A map of the 3D scene,
navigation controls and the Close button appear.

T I P S

o You can press the gray border of themap to drag it to another area of the page if it’s
coveringmaterials you want to present. You can also resize themap by pressing and
dragging the gray border in the lower-right corner.

o You can press the gray background or center icon of a navigation control to drag it to
another area of the page if it’s coveringmaterials you want to present.
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3. Navigate the 3D scene using the navigation controls.

Button Use to:

A Change your orientation upward.

B Change your orientation to the left.

C Change your orientation to the right.

D Change your orientation downward.

E Raise elevation.

F Move forward in the scene.

G Move to the left in the scene.

H Move to the right in the scene.

I Move backward in the scene.

J Lower elevation.

Alternatively, you can use keyboard buttons to navigate the 3D scene.

Keyboard button Use to:

W Change your orientation upward.

A Change your orientation to the left.

D Change your orientation to the right.

S Change your orientation downward.
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Keyboard button Use to:

PAGE UP Raise elevation.

UP ARROW Move forward in the scene.

LEFT ARROW Move to the left in the scene.

RIGHT ARROW Move to the right in the scene.

DOWN ARROW Move backward in the scene.

PAGE DOWN Lower elevation.

ESC Close

N OTE

As you navigate the 3D scene, a red indicator in themap displays where you are in the scene
and the direction you are viewing. The arrow in the center indicates orientation. The arrow
becomes a circle when you’re facing directly up or down.

Level Incline Decline

Off-screen (level) Upward Downward

4. Press Close when you’re done.

Using Mixed Reality Tools for
SMART Document Camera
After inserting 3D models in your .notebook files using 3D Tools for SMART Notebook software, you
canmanipulate thosemodels usingMixed Reality Tools for SMART Document Camera.

Manipulating 3Dmodels usingMixed Reality Tools for
SMART Document Camera
Youmanipulate 3D models using your SMART Document Camera and themixed reality cube.
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To manipulate a 3D model using the mixed reality cube

1. Connect your SMART Document Camera to your computer and turn on the document camera.

2. Open the .notebook file, and then display the page containing the 3D model.

3. Place themixed reality cube under the SMART Document Camera, showing one side of the
cube to the camera.

SMART Notebook software enters Mixed Reality mode and assigns the 3D model to the cube. If
there is more than one 3D model on the page, move the cube until the animation on the page
indicates that the cube is connected to the 3D model you want to manipulate.

N OTE

SMART Notebook software enters Mixed Reality mode in this situation only if a 3D model is
on the page. Alternatively, you can enter Mixed Reality mode by pressingSMART Document
Camera in the toolbar, and then pressingStart Mixed Reality in the
SMART Document Camera window.
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4. Do any of the following:

o Tomove the 3D model on the screen, move the cube.

o To rotate the 3D model on the screen, rotate the cube in your hand.

o To unassign the 3D model from the cube, cover the cube’s markings with your hand.

N OTE

If you experience any of the following symptoms, the causemay be issues with tracking:

o The 3D model doesn’t connect to the cube.

o The 3D model shakes when it’s connected to the cube.

o The 3D model sporadically disconnects from the cube.

o SMART Notebook software enters Mixed Reality mode when the cube is under the
camera even if you aren’t moving the cube.

To address tracking issues, see Lighting requirements on page 62.

T I P S

o As youmove and rotate the cube in your hand, ensure you don’t cover the symbols on the
cube’s surface.

o To hide the image from the SMART Document Camera and show only the 3D model,
move the transparency slider to the left.

5. If you’ve purchased a second cube from SMART and there is more than one 3D model on the
page, manipulate another 3D model by completing steps 3 and 4 with the other cube.

N OTE

The two cubes must have different patterns if you want to use them both at the same time.

6. When you’re done, move the cube (or cubes) away from the camera.

SMART Notebook software exits Mixed Reality mode after a few seconds.

Disguising 3Dmodels before presenting them
If you want to hide 3D models in your .notebook file before presenting them, you can use the Disguise
feature to hide the 3D models with amagic hat.

When you useMixed Reality Tools, themagic hat disappears after Mixed Reality Tools assigns the
3D model to the cube, revealing the 3D model.
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N OTE

If you hidemultiple 3D models on the same page with magic hats, eachmagic hat has a different
colored ribbon.

To hide a 3D model with a magic hat

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Disguise > Disguised.

To change the magic hat’s color

1. Select themagic hat.

2. Press themagic hat’s menu arrow, and then select Disguise > Change Color.

To reveal a 3D model under a magic hat

UseMixed Reality Tools as described inManipulating 3D models usingMixed Reality Tools for
SMART Document Camera on page 69.

After Mixed Reality Tools assigns the 3D model to the cube, stars swirl around themagic hat,
and then themagic hat disappears, revealing the 3D model behind it.

T I P

You can also reveal the 3D model by pressing the hat icon in the lower-left corner.

Using SketchUp sketching software and
Trimble 3D Warehouse
You can use the following 3D tools with 3D Tools for SMART Notebook software andMixed Reality
Tools:

l SketchUp sketching software

l Trimble 3D Warehouse (formely Google 3D Warehouse)
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Using SketchUp sketching software
You can use SketchUp sketching software to create 3D models. You can save these 3D models in
COLLADA (.dae) format and then insert them in SMART Notebook software.

To save a 3D model in .dae format

1. Open the 3D model in SketchUp sketching software.

2. Select File > Export > 3D Model.

TheExport Model dialog box appears.

3. Browse to where you want to save the file.

4. Type a name for the file in the File name box.

5. Select COLLADA File (*.dae) in theExport type drop-down list.

6. Press Export.

To insert the 3D model in SMART Notebook software

See Inserting 3D models on page 63.

Using Trimble 3DWarehouse
Trimble 3D Warehouse (formerly Google 3D Warehouse) is an online repository of 3D models. Using
this link in the SMART Notebook software Gallery tab, you can search for 3D models and download
them to your computer. You can then insert the 3D models into your .notebook files.

To download 3D models

1. Press theGallery tab.

2. Press Google 3D warehouse.

3. Search or browse for a 3D model that you want to download.

Select themodel.

4. Press Download Model, and then press theDownload link besideCollada (.zip).

N OTE S

o When you first download a 3D model, you could be asked to provide a nickname.

o If you’re usingMac OS X operating system software and you cancel the download, the
3D model still saves to theDownloads folder.
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5. Save the .zip file to your computer.

6. Extract the contents of the .zip file to a folder on your computer.

To insert a downloaded 3D model

See Inserting 3D models on page 63.
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Chapter 8: Troubleshooting
This chapter includes troubleshooting information for your SMART Document Camera.

Document camera issues
Use the following table to troubleshoot issues with your document camera.

N OTE

These procedures vary depending on your version of Windows operating system and your system
preferences.

Issue Solution

The power light turns orange
in standby mode.

Press the power button again to turn it on. The power light
turns green.

No camera image displays
(Cameramode).

l Ensure your document camera is turned on.
l Check all cable connections.
l Check the TV/VGA switch on the right-side connection panel of

your document camera and set it to the type of display device
you have.

l Reset the output resolution to 1024×768 by using a pen tip or
other small object to press the resolution reset button on the
bottom of the document camera.

No computer image
displays
(Computer Pass-Through
mode)

l Ensure your document camera is turned on.
l Check all cable connections.
l Check the cable connections from the computer VGA output to

the VGA input of your document camera.
l Ensure your document camera is in Computer Pass-Through

mode.
l On the some laptop computers, you can press FN+F5

repeatedly to toggle between display modes and the computer
image on the presentation screen.
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Issue Solution

The presentation screen is
dark and unreadable.

l Turn on Auto Image in your document camera’s on-screen
display (OSD)menu (Menu > IMAGE > Advanced > Auto
Image) to adjust the image brightness..

l Reset your document camera to its default settings (Menu >
SYSTEM > Default > Yes > Enter).

l Make sure there’s enough light in the room, or turn on the
overhead light on your document camera.

l Adjust the brightness and contrast levels manually in the
document camera's OSD menu, or use the control panel
buttons.

l If you are using a projector, check the bulb.

The image on the
presentation screen is
distorted or blurry.

l Reset your document camera to its default settings (Menu >
SYSTEM > Default > Yes).

l Adjust the brightness and contrast manually to reduce the
distortion.

l Press the button on the control panel if the image is blurry or
out of focus.

SMART Notebook software
doesn’t detect your
document camera.

l Make sure your USB cable is connected.
l Make sure the USB switch is set to .
l Make sure your software is up-to-date (you should have at least

SMART Notebook software 11 SP1).
l Make sure the USB cable and the computer USB receptacle are

working properly.
l Make sure the USB to PC setting is set toCAMERA in the

document camera's OSD menu.

SMART Notebook software
enters Mixed Reality mode
unexpectedly.

l Press SMART Document Camera in the toolbar.

l Press Additional Settings , and then clear the selection of
Automatically Start Mixed Reality Tools.

1. N OTE

To enable the automatic detection of Mixed Reality again,

press Additional Settings , and then select
Automatically Start Mixed Reality Tools.
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Issue Solution

No image appears when

you press the button.

l Insert an SD/SDHC card or USB drive with stored images, or
capture an image to the embeddedmemory.

1. N OTE

Images need to be stored in the available memory location in
order to enter Playback mode.

l Disconnect the USB cable or set the USB switch to .

Your document camera
doesn't detect the inserted
USB drive.

Ensure the USB switch is set to .

You're unable to record a
video (the red recording light
doesn’t turn on).

l Ensure an SD/SDHC card or USB drive is installed.

l Disconnect the USB cable (the document camera doesn't
record video while being used as a USB camera or mass
storage device).

The SD/SDHC card or USB
drive doesn't play video
properly, or the document
camera stops responding
during video recording.

Format the SD/SDHC card or USB drive using the document
camera's OSD menu (Menu > SETTING > Format > SD
CARD / USB DRIVE).

1. C A U T I ON

This erases all the data on the SD/SDHC or USB drive.

Your document camera has
an issue not described
above.

Restart the document camera using the power button on
the control panel.
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Appendix A: Hardware environmental
compliance
SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment
sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies
products, we strongly encourage you to properly recycle the electronic product when it has reached
the end of its life. If you require further information, please contact your reseller or
SMART Technologies for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances
(RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas, and that reference the European Union’s RoHS directive.

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The
packaging used by SMART Technologies to ship products complies with applicable packaging laws.
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